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President’s Message 
State President Kathy Jaqua 

Western Carolina University, Cullowhee, NC 
 kjaqua@email.wcu.edu 

The Single Most Important Math Skill… 
 
Every time I’m standing in line at the grocery checkout, I see a magazine advertising an article based on a version of 
“If you could ask (fill in the blank here with some historical or religious name) just one question, what would it be?” I 
think about that question for a few minutes, and then the line moves, and I go on with the rest of my day. I rarely think 
about that question again. I do, however, have one of those questions of my own that is not about a person and that I 
think about regularly. My question is “If you could teach every child one math skill, what would it be?” 

I’ve posed this question to groups of teachers, to groups of students, and to individuals. I get lots of different 
answers. Some people choose a specific skill such as knowing the multiplication tables; others choose a general 
answer such as solving algebraic equations. I answer that question with a math skill that may not sound like a skill at 
all. I want to teach every child the skill of asking why.  

We teach children many different math skills every day, and generally we ask them why many times a day. I 
do believe that it is important for students to be able to do particular tasks in math and to understand why the 
techniques that they use work; so those tasks and questions are critical. But the skill that I want to teach children is 
the skill of asking why themselves. It is no coincidence that one of the first questions that young children ask is 
why. “Why is the sky blue? Why do puppies bark? Why is rain wet?” The wonder of the world is new to them, and 
they want to know everything. They see, touch, hear, smell and taste everything that they can, and then they want to 
know why. Imagine a classroom where children do those same things with mathematical ideas.  

The skill of asking why is the heart of mathematics. What connects the ideas of whole number arithmetic to 
algebraic manipulations to calculus is the underlying question of why math works. Understanding why means that 
students don’t have to relearn a particular concept each time they encounter a new content area. A student asking 
why leads to a depth of knowledge that moves with them from one content area to the next.  

How do we help students develop the skill of asking why for themselves? The NC Standards for 
Mathematical Practice are certainly a beginning, as each of the Practices encourages children to approach 
mathematics from a thinking point of view. Developing students’ skill of asking why, however, requires more. 1) Skills 
have to be modeled authentically. That means as teachers we have to ask ourselves why in ways that children can 
observe. These questions must be true questions rather than a rhetorical device. 2) Skills have to be practiced. That 
means that as teachers we must plan activities that push students to ask why.  

Both of these tasks are challenging, and that is when we need to rely on each other. Participating in 
professional development opportunities such as those sponsored by the North Carolina Center for the Advancement 
of Teaching, working in PLCs in your school or district, attending conferences where teachers talk about what works 
in their own classrooms such as the Annual NCCTM conference are all ways to enhance our abilities to teach 
children to ask why. I offer another suggestion. Examine the content itself. Whatever level of mathematics that you 
teach, you can always learn something new about mathematical content. By looking at mathematics itself, you can 
find something that makes you ask why—something that strikes that chord of wonder that the young child has for 
everything. If you want a group to do math with, look around your area for a Math Teachers Circle. You can find a 
group of teachers from kindergarten through university who get together regularly to do math that they don’t 
necessarily teach and just to practice asking why for themselves.  

The next time you are in the checkout line, ignore the magazines, and ask yourself why about some 
mathematical idea. It won’t cost as much as any of the magazines on display, and you can share your wonder with 
your students, encouraging them to ask their own questions. You will be teaching them the single most important 
math skill: asking why for yourself. 

 

.   
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NCCTM’s State Math Conference Goes Virtual! 

 
 

To ensure that our members stay safe, we have moved the state conference online.  Our first sessions were very 
successful.   

 
 
Here are a few of the comments from participants: 

• Loved it. Learned a lot about virtual learning and things that I could use in my classroom. I wanted to see 
how other teachers set up expectations as well as other tools that I could use, and I got that from this video. 

• Another great session! It was good to hear how someone can implement Number Talks with online 
instruction. Also hearing ideas/ resources from peers from different parts of the state was helpful as well. 

• I enjoyed the opportunity to listen, converse and troubleshoot ideas with other math educators. 
• I love how we are able to share so many resources and classroom management suggestions with each 

other! I have many ideas that I'm able to take with me going into this school year. 
 

Watch the website for upcoming sessions! 
https://www.ncctm.org/conferences/state-mathematics-conference/ 

 
 

Thank You to Our Virtual Conference Sponsors! 
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NCCTM Statement on  
Equitable Access to Quality Mathematics Instruction 

 
As we mourn the unjust deaths of George Floyd, Breonna Taylor, and Ahmaud Arbery, the North Carolina Council of 
Teachers of Mathematics renews its commitment to promoting equitable access to quality mathematics instruction for 
the children of North Carolina.  Students need to experience mathematics in ways that allow them to be successful 
and that give them the power to change the world.  This experience needs to be delivered with both excellence and 
equality while resonating with the lives of Black, Latinx, Indigenous, Asian, and all marginalized peoples.  Racism 
cannot be tolerated, and we as teachers must be vigilant that we do not tolerate nor contribute to racism, bias, hate, 
or violence in our classrooms. 

Although these beliefs are the foundation of the work of the organization, we also acknowledge that severe 
gaps in equity exist and that we must continue to strive to close these gaps.  Acknowledgement of equity issues in 
content and access to quality mathematics education is an important first step, but real change will only occur with 
actions designed to bring about improvement.  We cannot change the past, but we can and do change the future as 
we educate children.  We can step forward to be part of a positive change to eliminate racism and bias as a part of 
everyday life for anyone. 

As an organization of educators, the North Carolina Council of Teachers of Mathematics will contribute to 
that change by providing pertinent professional development that helps us grow as teachers in our knowledge and 
skills for creating classrooms where every child can learn in a safe environment free from racism, bias, and 
oppression.  We commit to increasing diversity in our leadership, in our speakers, and in our work on behalf of the 
mathematics teachers and students of North Carolina. We will work to support the teachers of North Carolina in 
creating a mathematics environment where all students feel safe, valued as learners, and capable as 
mathematicians.  

 
NCTM Statement on Equity 

 
Creating, supporting, and sustaining a culture of access and equity require being responsive to students' 
backgrounds, experiences, cultural perspectives, traditions, and knowledge when designing and implementing a 
mathematics program and assessing its effectiveness. Acknowledging and addressing factors that contribute to 
differential outcomes among groups of students are critical to ensuring that all students routinely have opportunities 
to experience high-quality mathematics instruction, learn challenging mathematics content, and receive the support 
necessary to be successful. Addressing equity and access includes both ensuring that all students attain 
mathematics proficiency and increasing the numbers of students from all racial, ethnic, linguistic, gender, and 
socioeconomic groups who attain the highest levels of mathematics achievement. 
 
 

NCTM’s 100 Days of Professional Learning 
 
Check out NCTM’s Webinars!  A few examples:   
 
September 14: Building Students Mathematical Competence 
September 16: What’s the Point of Points? Rethinking the Assessment of Student Mathematics Work 
September 22: Celebrating 100 Years of Big Beautiful Problems 
 
For more information: https://www.nctm.org/online-learning/Webinars/list?status=live  
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Santa to the Rescue:  
Exploring the Use of Slope and the Pythagorean Theorem 

Ann Wheeler, Texas Woman’s University, Denton, TX , &  
Diana De Santiago, Gainesville Junior High School, Gainesville, TX 

 
 
 
 
 
 
 
 
 
The authors present 
holiday-themed activity 
that can be used to 
address 8th grade 
standards related to linear 
functions, slope, and the 
Pythagorean Theorem. 
 

Incorporating holiday-related themes into mathematics lessons can be an 
entertaining approach to enliven mathematical topics for students. We felt 
that utilizing the idea of Santa’s reindeer being missing might be a fun way to 
introduce a Christmas-themed lesson pertaining to two mathematics 
standards from the Common Core:  
 
• 8.F.B.4: Construct a function to model a linear relationship between two 

quantities. Determine the rate of change and initial value of the function 
from a description of a relationship or from two (x, y) values, including 
reading these from a table or from a graph. Interpret the rate of change 
and initial value of a linear function in terms of the situation it models, and 
in terms of its graph or a table of values; and  

• 8.G.B.7: Apply the Pythagorean Theorem to determine unknown side 
lengths in right triangles in real-world and mathematical problems in two 
and three dimensions. This activity also incorporates a problem-based 
challenge that should be a theme in any good mathematical task. 
(National Governors Association Center for Best Practices and the 
Council of Chief State School Officers, 2010). 

 
This article describes an activity designed to meet these two objectives. We 
used the activity with 30 preservice teachers (PSTs) enrolled in a middle 
school mathematics methods and content course, who worked in groups of 
up to four. The first task required the PSTs to create linear functions. For the 
second task, the PSTs tested their knowledge of using the Pythagorean 
Theorem. A full-sized version of the provided worksheet follows this article. 

 
Problem #1: Oh, no! Santa is going to be mad! 

Help! The elves left the reindeer pen open overnight and four 
reindeer got out! Can you help the elves get them back before Santa 
comes home? On the graph paper (Fig. 1), write the equation of the 
line segment that the elves would need to reach each reindeer. The 
line segment should start from the square-shaped pen on the left and 
go diagonally to each reindeer. The elves can only carry one reindeer 
at a time.  
 

The PSTs used the provided grid paper (Fig. 1) that shows the reindeer pen, 
as well as Vixen, Rudolph, Dasher, and Dancer placed strategically 
throughout the first quadrant of the coordinate system. Two of the reindeer 
were below the pen, whereas the other two were placed above the pen. This 
allowed for PSTs to determine two negative and two positive slopes with a 
fixed y-intercept at the location of the pen, (0,11). 
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Figure 1. The grid showing the position of the reindeer. 

 
Sample Work for Problem #1 
Most PSTs correctly calculated the slopes of the line segments created between the pen and each reindeer. See 
Figure 2 for an example of work where PSTs created the triangular regions between the pen (at the far left) and each 
reindeer, as well as their corresponding equations. 

 

       
Figure 2. Sample PST work for problem #1. 

 
All but one PST stated the correct y-intercept, but some PSTs had problems with correctly writing the slope. The 
most common errors were counting the number of units incorrectly, such as stating -4 for the slope for Dancer when it 
should have been -3 and stating the slope upside down, such as stating the slope for Dasher as -4 instead of		!"

#
. 
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Problem #2: Did the elves get all their steps in? 
The elves are exhausted! Santa wants to know the total distance the elves traveled to get the reindeer. Using 
the Pythagorean Theorem, calculate the total distance the elves traveled. 

 
PSTs used their provided grid paper to create triangles to calculate the distance each reindeer traveled, as well as 
the cumulative distance the elves traveled to collect all the reindeer. 
 
Sample Work for Problem #2 
Twenty-six of the 30 PSTs correctly calculated the total distance the reindeer’s traveled. Figure 3 shows a 
representative example of work from a PST who did the work correctly.  
 

      
Figure 3. Sample Pythagorean theorem PST work. 

 
Two of the four PSTs who incorrectly answered the problem did not double the length of each hypotenuse found. 
There was a discussion by the teacher and the class about how to calculate the total distance to help PSTs not make 
this error. The other two incorrect answers were from PSTs who did not find the total distance but did correctly 
calculate the distance that each reindeer individually traveled. 
 
Conclusion 
Using holiday-themed mathematics lessons can be a fun and engaging exercise for students. During this activity, 
PSTs wrote the equations of line segments that represent the paths elves would take to reach the reindeer, as well 
as utilized the Pythagorean Theorem to calculate the distances Santa’s elves traveled to retrieve the reindeer. The 
PSTs enjoyed being able to take often procedurally-taught topics and work through an activity that involved an 
interesting scenario to solve. 
 
Reference 
National Governors Association Center for Best Practices and the Council of Chief State School Officers. (2010). 

Common core state standards for mathematics. Washington, DC: Author. Retrieved from  
http://www.corestandards.org  
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Activity: The Reindeer are Missing! 
 
Directions: Help! The elves left the reindeer pen open overnight, and four reindeer got out! 
Can you help the elves get them back before Santa comes home? Write the equation of 
the line segment that the elves would need to reach each reindeer. The line segment 
should start from the pen and go diagonally to each reindeer. The elves can carry only one 
reindeer at a time. 

 
 

Vixen:        Rudolph:        
 
Dasher:        Dancer:        

 
Extension: The elves are exhausted! Santa wants to know the total distance the elves 
traveled to get the reindeer. Using the Pythagorean Theorem, calculate the total distance 
the elves traveled. 
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A Visual Proof of the Pythagorean Theorem 
Betty B. Long & Deborah A. Crocker, Appalachian State University, Boone, NC 

 
 
 
 
 
 
 
 
 
The authors present a 
hands-on, proof without 
words for students to 
investigate the 
Pythagorean Theorem. 
 

There are a number of visual or informal proofs of the Pythagorean Theorem.  
These types of proofs are often called “proofs without words.”  They are used 
to help students see how the Pythagorean Theorem works and why it is true.  
There are many such proofs. Veljan (2000) attributes the approach used in 
this patty paper activity to Chou-pei Suan-ching of China (ca. 250 BC).  It 
involves cutting a larger square into four right triangles and a smaller square.  
Using algebra, students can discover the Pythagorean Theorem and develop 
a little more understanding about it. 

In the North Carolina Mathematics Standards for Middle Grades 
(North Carolina Department of Public Instruction, 2017), the following 
standard is listed: 

Understand and apply the Pythagorean Theorem 
NC.8.G.6. Explain the Pythagorean Theorem and its converse. 

 
The proof provided below is one way to meet this standard.  Since the 
algebra involved is high school level, this could be an activity to use as a 
review of the Pythagorean Theorem for high school students and for some 
practice of algebra skills.  The algebra skills used for the activity include the 
distributing of a constant, multiplying linear expressions, and combining like 
terms.  We provide instructions for the student and suggestions for the 
teacher below. 
 
Handout for the Students 
1. Use one sheet of patty paper. Put a mark on one side. Label one part of 

the side “a” and the other “b” as shown: 

 
 

2. Use the first sheet of patty paper to make a similar mark on all four sides 
of another sheet of patty paper, and label all of the lengths “a” and “b” as 
shown below. 
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Write a formula for the area of the sheet of patty paper using the letters a and b.  
 

3. Fold from point to point on adjacent sides and label the hypotenuse “c” on each right triangle you make, as 
shown below. 

 
 

a. Using the labels in the figure, write the area of one of the triangles.   
b. Using the labels in the figure, write the area of the small interior square. 
c. Using the four triangles and the small square, write the area of the original sheet of patty paper. 

 
4. Since the area of the sheet of patty paper is the same no matter which way you write it, the two expressions for 

area must be equal.  Write an equation setting them equal to each other.  Simplify that equation. What do you 
see? 

 
Suggestions for teachers 
The students will need two pieces of patty paper and a ruler. Once the students have selected the position for the 
point and copied that location to all four sides, they need to write the area of the patty paper in two different ways 
using the labels on the patty paper: (1) the area of the entire square of patty paper, and (2) the sum of the areas of 
the four triangles and the smaller square.  The diagrams on the student handout can be used with the algebra shown 
below.  You may have to encourage your students with a hint to get them started. 
 
The area of the whole sheet of patty paper, with the labeling above: 
 

(𝑎 + 𝑏)$ 
 

The area of the whole sheet of patty paper using the square plus the area of the four right triangles: 
 

𝑐$ + 4)
1
2𝑎𝑏, 

 

Since the area of the square piece of patty paper is equal to itself: 
 

(𝑎 + 𝑏)$ = 𝑐$ + 4)
1
2𝑎𝑏, 

Simplify the previous equation as shown below: 
 

(𝑎 + 𝑏)$ = 𝑐$ + 4)
1
2𝑎𝑏, 

 

𝑎$ + 2𝑎𝑏 + 𝑏$ = 𝑐$ + 2𝑎𝑏 
 

𝑎$ + 𝑏$ = 𝑐$ 
 
Now you have the Pythagorean Theorem.  Students can see the connections between the areas created on the patty 
paper.  An extension of this activity might be to investigate other visual or informal proofs of the Pythagorean 
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Theorem.  For a project, have students find other approaches and share them in class, on a poster, or in a 
presentation. 
 
References 
North Carolina Department of Public Instruction. (2017). North Carolina K-8 math standards.  Retrieved from 

https://www.dpi.nc.gov/teach-nc/curriculum-instruction/standard-course-study/mathematics 
Veljan, D. (2000). The 2500-year-old Pythagorean Theorem.  Mathematics Magazine, 73(4), 259-272.  Doi: 

10.2307/2690973 
 
 
 

In Memoriam: 
Robert (Bob) Ralph Jones, Jr. 

It is with great sadness that NCCTM has learned of the passing of one of our founders, Bob 
Jones. Bob played an instrumental role in working to organize a meeting that would give 
birth to NCCTM.  

In 1970, as Supervisor of Mathematics for the State Department of Public 
Instruction, Bob—along with Bob Clary, Josie Thomson, and Hunter Ballew—started 
conversations about forming a new state organization for math teachers. A proposal was 
written to NCTM for funds to underwrite a meeting of mathematics leaders from across the 
state to plan the organization's structure. 

NCTM funded this proposal and Bob, Josie Thompson, and Hunter Ballew 
organized the meeting and sent a letter of invitation to those identified as leaders in the 
North Carolina mathematics education community. A core group of 20 leaders from around the state attended a 
meeting in Bryson City in October to brainstorm—a gathering now considered to be the first meeting of NCCTM. The 
group felt strongly that this proposed organization could take on the responsibilities of sharing the content, pre-
service, and in-service experiences in primary and secondary mathematics. 

Through his career in education and administration and his involvement in NCCTM, Bob had a huge impact 
on mathematics education in North Carolina. We send our deepest sympathies to Bob’s family at this sad time. He 
will be sorely missed! 

 
 

Rankin Award Nominations 
 
The Rankin Award is designed to recognize and honor individuals for their outstanding contributions to NCCTM and 
to mathematics education in North Carolina. Presented in the fall at the State Mathematics Conference, the award, 
named in memory of W. W. Rankin, Professor of Mathematics at Duke University, is the highest honor NCCTM can 
bestow upon an individual. 
 
The nomination form can be obtained from the “awards” area of the NCCTM Website, www.ncctm.org. More 
information can be obtained from Lee V. Stiff, lee_stiff@ncsu.edu. 
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2020 NCCTM Logo Contest Winners 
Reported by Anthony Finlen, Asheboro, NC 

 
The Mathematics Logo Contest is held each spring. The NCCTM Board selects the winning logo at its Spring 
meeting. The 2020 winning logo, pictured, will be available on shirts at the NCCTM State meeting in October. 
 
State Winner:  

Minseo Choi 
5th Grade Student at McAlpine Elementary  

Teacher: Sarah Koch 
 

Other Finalists: 
 
Eastern 
 
Student - Grade - Teacher  
Blayden Miller - 8 - Jenks Johnson 
Brantley Edwards - 10 - Peggy Walston 
Camryn Joyner - 10 - Peggy Walston  
Cartyr Kittrell - 4 -Tiffany Phillips 
Isabella Turner - 8 - Jenks Johnson 
Matthew David - 9 - Jenks Johnson 
Nacir Lewis - 7 - Jenks Johnson 
Tanner Williams - 4 - Tiffany Phillips 
Thomas Yoo - 11 - Cherry Devane  
Zanyah Barbour - 5 - Kimberly Lunde 
 
Central 
 
Student - Grade - Teacher  
Hailey - 2 - Miranda James 
Kenzie Edwards - 9 - Amy Owens 
Lilee - 2 - Miranda James  
Lydia Wisdom - 7 - Angela Short 
Mary Bun - 7 - Karen Pardo 
Rileey Lawson - 5 - Christy Hutchins 
Skylar Schaal - 5 - Christy Hutchins 
 
Western 
Savanah Wilcox - 11 - Carmen Wilson 
 
 

 

Innovator Award Nominations 
 
The North Carolina Council of Teachers of Mathematics accepts nominations for the Innovator Award at any time. 
The Committee encourages the nomination of organizations as well as individuals. Any NCCTM member may submit 
nominations. The nomination form can be obtained from the “awards” area of the NCCTM Website, www.ncctm.org. 
More information can be obtained from: Dr. Ana Floyd, afloyd@randolph.k12.nc.us. 
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Using RStudio Cloud with a High School Class 
Alan T. Arnholt & Suzanne R. Arnholt, Appalachian State University, Boone, NC 

 
 
 
 
 
 
 
 
 
The authors describe a 
real-world data-fitting 
activity using RStudio 
Cloud, along with 
directions for how to get 
started in the RStudio 
environment. 
 

The study of statistics has changed drastically since the advent of the internet 
and the creation of incredibly fast computers. Data sets used in class have 
moved from a few values in one or two variables to hundreds of variables 
with thousands of cases. Calculators are insufficient to do modern statistics, 
yet they have been the tool of choice in elementary and high schools for 
years. With RStudio Cloud, elementary and high school teachers tasked with 
starting students’ statistics education have access to a premier computing 
platform used by professionals worldwide. Assignments can be created and 
distributed electronically, which is much more sustainable than passing out 
papers with problems. A diverse student population can be served equitably, 
as all students will have access to the leading computational platform in the 
field. Using RStudio Cloud in the teaching of statistics at any level enhances 
students’ understanding of modern statistics. This paper will detail how to get 
RStudio accounts for both teacher and students, describe how to create and 
distribute an assignment to a class, and provide a sample link to an 
assignment including a data set whose analysis should be of interest to 
present day students. 
 
Getting an Account 
RStudio Cloud’s login page can be found at https://rstudio.cloud. If you work 
at a school with Google accounts, it is advisable to have students (and the 
teacher) sign up with Google. At the time of publication of this article, the 
“sign up” link is on the top right of the main page or on the bottom right of the 
login page. You may also sign up with any valid e-mail address. Once you 
have signed up, you can log in. If you click “info,” you can read an intro to 
RStudio Cloud as well as the User’s Guide (RStudio Cloud, n.d.). The same 
process you use as a teacher can be used by your students to create their 
own accounts. 

When you want a location for a particular class’s assignments, you 
will create a Private New Space by clicking on New Space (Fig. 1). 
 

 
Figure 1. Top left corner of RStudio Cloud 

 
The number of new private spaces is somewhat limited without an upgrade, 
so if you plan to use this system for many semesters or classes, asking for an 
upgrade is a good choice. Once the new private space is created, say 
“MyClasses,” click on it. Near the top center of the screen is a list of 
“Members.” Initially, you are the admin and the only member of your space.  
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You can “invite” your students to join your space with their e-mail addresses. Each student must be invited 
individually. You could also set the access to Shared, then distribute the Sharing Link (copy sharing link shows up as 
an option once you click shared) to your students. Once all the students have joined the space, you can then set 
Access to “Invitation Required” to ensure that nobody joins the class later without your permission. The latter method 
is easier. Again, you may need to request more members with the Capacity link at the bottom right screen 
 
Creating Assignments 
A good way to create assignments for your students is to make a project for each assignment and populate it with the 
files, data sets, and packages you would like each student to have when they begin the assignment. It is also a good 
idea to create a base project that contains files and packages your students will typically use. Our students typically 
use rmarkdown (Allaire et al., 2019), a few of the packages from tidyverse (Wickham, 2017), and bookdown (Xie, 
2020). Consequently our base project has the rmarkdown, tidyverse, and bookdown packages and all of their 
dependencies installed. To create a base project, click New Project. Deploying Project will appear as RStudio Cloud 
loads a basic distribution of R with commonly used packages. Name your base project by clicking on the Untitled 
Project to the right of your private space name (MyClasses in this example). Once the RStudio interface displays, add 
the packages rmarkdown, bookdown, and tidyverse by: 
 

• Clicking on the Packages tab in the bottom right pane. 
• Clicking on the Install icon in the bottom right pane. 
• Typing the names (rmarkdown, bookdown, tidyverse) in the Packages box of the Install Packages window. 
• Make sure the box to the left of Install dependencies is checked. 
• Click the Install button. 

 
Next, 

• Click on the gear box in the top right of RStudio Cloud. 
• Click on the Access icon and change who can view the project to “Everyone in MyClasses.” 

 
To set all of your future projects in MyClasses to use the files and packages in your base project, return to the 
MyClasses space then click the gear box in the top right of RStudio Cloud and set the base project. Figure 2 shows 
the gear box in the top right and an example of setting the base project to base of a space named MyClasses. To use 
the functions and data sets in an R package, the package must be installed and loaded. Packages need only be 
installed once but must be loaded each R session. Packages are generally loaded at the R prompt with the 
command: library(Package_Name). 
 

 
Figure 2. Screen shot of space settings window of RStudio Cloud. 
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To create your first assignment in a project named FirstAssignment, first click on the MyClasses space under 
Spaces. Next, click New Project and remember to name the project by clicking on the Untitled Project and typing 
FirstAssignment. 

To create an R script file, select File > New File > RScript from the top right of the interface. Once you have a 
bit of code, you can save your script with File > Save As. In the lab explained later in this article, the first bit of code is 
given in Figure 3. 
 

 
Figure 3. Code to enter for the lab. 

 
The best way to ensure that your students each get their own copy of the project is to flag the project as an 
assignment. To create an assignment: 
 

1. Open the project. 
2. Click on the Project Settings button (the gear icon in the upper right). 
3. Select the Access icon. 
4. Verify that the project can be viewed by everyone in the space (the default is You). 
5. Check Make this project an assignment. 

 
When the student opens an assignment project (either via the projects listing, or via a link to the project), RStudio 
Cloud will automatically make a copy for them. To convey this special behavior, assignments are displayed a bit 
differently. You can see the students’ copies of the assignment by clicking on the “View n derived projects” link that 
will appear with your original project. Note that changes you make to the original assignment will not be applied to 
any student copies already created. The changes will only apply to future copies of the assignment. Also note that the 
assignment feature is not available in your personal workspace (RStudio Cloud, n.d.). 
 
Forced Expiatory Volume Lab Intro 
Now that you have familiarized yourself with the interface, you will certainly want to create assignments for your 
class. A Journal of Statistical Education article by Kahn (2005), has information about a measure of lung capacity 
(fev) as well as variables that might be related to it (height, age, sex, smoker). The dataset and a description are 
available in the JSE Data Archive (http://jse.amstat.org/jse_data_archive.htm; search for “fev”). The data will provide 
an excellent illustration of confounding variables and may convince students that smoking is not a good choice for 
them. 

In the lab itself, reasonable questions to have the students answer include: 
• How are fev and smoke related overall? 
• How are fev and age related for smokers and non-smokers? 
• How are fev and sex (fm) related for smokers and non-smokers? 
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• How are fev and height related for smokers and non-smokers? 
• Based on these answers only, does it appear that smoking is detrimental to fev? 
• Since it is generally accepted that smoking is not good for lung function, what may be causing this? 

That is, what paradox seems to be in effect? Create a graph that accurately reflects the effect of 
smoking on fev, including all appropriate variables. 

 
Forced Expiatory Volume Lab R Commands and R Markdown Rationale 
As the tidyverse has developed, a few ideas have become standard. The first idea is that data should be “tidy.” This 
generally means that each row represents an observation and each column is a variable (Wickham, 2014). The 
second idea is that graphs should be created that follow a particular grammar. Graphs in the tidyverse are generally 
created with the ggplot2 package using the ggplot( ) function (Fig. 5). 

A typical ggplot( ) graph starts with “tidy” data passed as either a data frame or a tibble to the “data =” 
argument. Aesthetic mappings such as x and y are specified in aes( ) and geom_, which specifies the type of 
geometry one desires. The arguments for the aesthetics determine the coordinate system, while the various geoms 
determine the visual marks that represent the data.  
 

 
Figure 4: Screen shot of help path to ggplot2 cheat sheet. 

 
The “Data Visualization with ggplot2” cheat sheet provides helpful reminders for using ggplot2 and is available in the 
RStudio Integrated Development Editor by clicking Help > Cheat Sheets > Data Visualization with ggplot2 (Fig. 4). 
A template for creating the graphs in the lab provided with this article is given in Figure 5. 
 

 
Figure 5. Graph template for the lab. 

 
Two separate documents ready to use for this lab are included at https://rstudio.cloud/project/649008 (you will need 
to log in to access this project site; as noted above we suggest using a google account to do so). One is the actual 
lab to assign to students (Lab.Rmd); the other is a partial key (Key.Rmd). Both documents are provided in R 
Markdown format as advocated by Horton et al. (2014) and Baumer et al. (2014).  

There are many outstanding online reference texts for using R Markdown (e.g., Xie, 2020; Xie et al., 2020). 
For a short tutorial, see Using R Markdown with the RStudio Integrated Development Editor (Arnholt, 2017a). For 
some additional ideas for using R Markdown, see Using R with the RStudio Integrated Development Editor—Ideas, 
Pointers, and Teasers (Arnholt, 2017b).  
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Conclusion 
With the availability of cloud computing, any teacher and any student can access the best and most up-to-date 
statistical analysis tools to solve problems. With internet access and a device that can connect to the internet, anyone 
with appropriate motivation can solve problems that would have been intractable and time consuming for even 
professional statisticians 50 years ago. It is our hope that this paper has provided enough guidance that RStudio 
Cloud will become the new favorite tool of statistics analysis at every level of education. 
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Applying for NCCTM Mini-grants 
 

NCCTM provides funding for North Carolina teachers as they develop activities to enhance mathematics education. 
This program will provide funds for special projects and research that enhances the teaching, learning, and 
enjoyment of mathematics. There is no preconceived criterion for projects except that students should receive an on-
going benefit from the grant. In recent years, grants averaged just less than $800.  

The application is available on the NCCTM website [ncctm.org]. Proposals must be postmarked or emailed 
by September 15, and proposals selected for funding will receive funds in early November. Be sure that your NCCTM 
membership is current and active for the upcoming year! Each year we have applications that cannot be considered 
because of the membership requirement. Email Joy McCormick [jmccormick@rock.k12.nc.us] with questions.  
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Problems2Ponder 
Holly Hirst, Appalachian State University, Boone, NC 

 
In each issue of The Centroid, Problems2Ponder presents problems similar to those students might encounter 
during elementary and middle school Olympiad contests. Student solution submissions are welcome as are problem 
submissions from teachers. Please consider submitting a problem or a solution. Enjoy! 
 
Problem submissions: If you have an idea for a problem to publish, please email Holly Hirst (hirsthp@appstate.edu) a 
clear photo or PDF document of a typed or neatly written problem statement, along with a solution. Include your 
name and school affiliation so that we can credit you with the submission. 
 
Solution submissions: If teachers have an exceptionally well written and clearly explained correct solution from a 
student or group of students, we will publish it in the next edition of The Centroid. Please email Holly Hirst 
(hirsthp@appstate.edu) a clear image or PDF document of the correct solution, with the name of the school, the 
grade level of the student(s), the name of the student(s) if permission is given to publish the students’ names, and the 
name of the teacher. 
 

Deadline for publication of problems or solutions in the Fall 2020 Centroid: December 30, 2020. 
Solutions will be posted in the next edition of The Centroid. 

 
Fall 2020 P2P Problems 
 
Problem A: A train is exactly 12 miles from Greensboro at 7:00 PM. It is traveling at a constant speed of 45 mph. At 
what time will the train reach the terminal in Greensboro? 
 
Problem B: The Math Olympiads began in the prime year 1979. Find the product of the fractions below in simplest 
form 

)1 −
1

1980, )1 −
1

1981, )1 −
1

1982,…)1 −
1

2004, )1 −
1

2005, 

 
 
Spring 2020 P2P Problem Solutions 
 
Both of these problems involve number and operation and have multiple solution approaches! 
 
Problem A: A, B, and C represent digits in the following subtraction problem. Find the sum of A, B, 
and C. 
 
Solution: There are many ways to think about this problem. One way to approach the problem is to 
rewrite the subtraction as addition of 𝐶	7	8 and 3	7	𝐵, which must equal 8	𝐴	4. 
 
Now look at the individual place values:  

• In the ones position, 8 + 𝐵 cannot equal 4 for any positive value of B so it must be 14, resulting in 𝐵 = 6 
and regrouping of the 10. 

• In the tens position, 1 + 7 + 7 is 15, resulting in 𝐴 = 5 and regrouping again. 
• In the hundreds position, 1 + 𝐶 + 3 = 8, results in 𝐶 = 4. 
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Problem B: the first four terms of the sequence 2, -3, -2, 3, 2, -3, -2, 3,… repeat endlessly. Find the sum of the first 
2013 terms in this sequence. 
 
Solution: As with problem A, there are many ways to solve this problem and we will see that the number 4 plays a 
crucial role.  
 
Since we want to know the sum of many terms, we can start by listing the “partial sums” of 1 term, then 2 terms, then 
3 terns and so on to gain understanding of how the sums behave. In the table below are the sums of the first 7 partial 
sums, and a pattern has appeared. 
 

Number 
of terms 

 
Partial Sum 

 
Total 

1 2 2 
2 2+(-3) -1 
3 2+(-3)+(-2) = -1+(-2) -3 
4 2+(-3)+(-2)+3 = -3+3 0 
5 2+(-3)+(-2)+3 + 2 = 0+2 2 
6 2+(-3)+(-2)+3+2+(-3) = 2+(-3) -1 
7 2+(-3)+(-2)+3+2+(-3)+(-2) = -1+(-2) -3 
8 2+(-3)+(-2)+3+2+(-3)+(-2)+3 = -3+3 0 

 
• Adding either 1 or 5 terms result in 2  
• Adding either 2 or 6 terms results in -1  
• Adding either 3 or 7 terms results in -3  
• Adding either 4 or 8 terms results in 0  
• These totals will repeat: 0 for a multiple of 4; 2 for one more than a multiple of 4; etc. 

 
Since the total repeats, so we just need to determine which of these four possibilities is the sum for 2013! Since 2013 
divided by 4 is 503 with a remainder of 1, the sum will behave like the sum of 1 term or 5 terms, so the answer is 2! 
 

 
 

Trust Fund Scholarships: Now $1000 
 
Scholarships are available from NCCTM to financially support North Carolina teachers who are enrolled in graduate 
degree programs to enhance mathematics instruction. Applicants must be: 

• Currently employed as a pre-K-12 teacher in North Carolina; 
• Currently an NCCTM member (for at least one year) at the time of submitting the application; 
• Currently enrolled in an accredited graduate program in North Carolina; 
• Seeking support for a mathematics or mathematics education course in which they are currently enrolled or 

have completed within the previous four months of the application deadline. 
 
Applications will be reviewed biannually, and the deadlines for applications are March 1 and October 1. The 
application can be downloaded from the NCCTM website under the “grants & scholarships” link. The nomination form 
can be obtained from the grants and scholarships page on the NCCTM Website (ncctm.org). More information can be 
obtained from: Janice Richardson Plumblee, richards@elon.edu. 
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Donating to the NCCTM Trust Fund 
 
Did you receive a Trust Fund Scholarship that helped you to complete your graduate coursework and you want to 
show appreciation? Do you wish to memorialize or honor someone important to you and your career as a math 
teacher? 

Consider making a donation to the NCCTM Trust Fund, please send your donation, payable to Pershing LLC 
for the NCCTM Trust Fund, to: 

Joette Midgett 
North Carolina Council of Teachers of Mathematics 
P. O. Box 33313 
Raleigh, NC 27636 

Puzzle 
Holly Hirst, Appalachian State University, Boone, NC 

 
Have you seen the version of Sudoku called “Killer Sudoku”?  It combines a KenKen-like puzzle and a Futoshiki-like 
puzzle with traditional Sudoku.  Below are two from the website https://www.dailykillersudoku.com/, one easy and 
one hard. The developer of that page, James, went from writing code to solve these problems to writing code to 
create them!  You can play daily puzzles or register to track your successes and look at the archived puzzles. 
 
The Rules (https://www.dailykillersudoku.com/): 
As with Sudoku, the objective of Killer Sudoku is to fill the grid with the numbers 1 to 9, such that each row, column 
and nonet (3x3 group of cells) contains each number only once. In addition to this, a Killer Sudoku grid is divided into 
cages, shown with dashed lines. The sum of the numbers in a cage must equal the small number in its top-left 
corner. The same number cannot appear in a cage more than once. 

Greater-Than Killer Sudoku has exactly the same rules as Killer Sudoku, except that not every cage has a 
sum in its top-left corner. Instead, some cages are linked together with symbols: 

< The left cage's sum is less than the right cage's sum. 
= The left cage's sum is equal to the right cage's sum. 
> The left cage's sum is greater than the right cage's sum. 
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